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  بسم االله الرحمن الرحیم

  

  

  جزوه آموزشی مباحث ویژه 

  SQLو  #Cزبان 

  
  

  

  

  

  

  

  

  

  

  

  استاد رجب کیانی نویسنده : 
  

  باشد. هرگونه برداشت پژوهشی با ذکر منبع و نویسنده بلامانع می
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  نمایه

  

  پیش گفتار

  SQL Serverبرخی از دستورات مهم بخش اول: 

  ایجاد پایگاه داده: بخش دوم

  هاي استفاده شده در پروژهآشنایی مفهومی با کلاسبخش سوم: 

  (به صورت گام به گام) stdTableي سازي عملی پروژهپیادهبخش چهارم: 

  ایجاد فایل اجرایی از پروژهبخش پنجم: 

  XMLخواندن از و نوشتن در یک فایل  بخش ششم:
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  گفتار پیش *
  

  SQLو  #Cزبان    مواد درسی:

  .که با سیستم آن آشنا هستید انتخاب موضوعی دلخواه

  نفره 2گروه حداکثر 

  انتخاب یک موضوع براي پروژه عملی

  دهید.مطالب هر جلسه را بر روي پروژه خود انجام می

  برخی موضوعات پیشنهادي:

 -بانک -گاهآموزش -سیستم ورود و خروج اداره -فروش بلیط -آژانس املاك -فروشگاه -انبارداري -حسابداري -کتابخانه
 -پذیرش بیمارستان -مدیریت سی دي کلوپ -یسآژانس تاکسی سرو- مدیریت کلاسها -آزمایشگاه -دبیرخانه -پذیرش بیمه
-کتابفروشی -انبارداري -صندوق بانک -آژانس رزرو بلیط قطار -سیستم دانش آموزان مدرسه -مدیریت باشگاه -مدیریت هتل

  سیستم هم اتاقی خوابگاه-مدیریت رستوران

 (پرسیده می شود.)  خواهیمشود در جلسه بعد میآنچه کار میهر جلسه 

باشد که براي درس مباحث ویـژه و انجـام   اي که هم اکنون در اختیار شما است، شامل شش بخش میجزوه
  باشد.لازم می  (stdTable)  ي آنپروژه

در این جزوه فرض بر این بوده که دانشجو با حداقل مفاهیم اصولی برنامه نویسی (روش کارکرد دسـتورات  
کنترلی، حلقه هاي تکرار، انواع متغیرها، متدها، پارامتر و . . . ) آشنایی داشته و مفاهیم اولیه برنامـه نویسـی   

بـا جزئیـات کـافی ذکـر       stdTable ذکر نشده است اما حتی الامکان سعی شده است مراحل ایجاد پـروژه 
  شده و نکات مهم آنها توضیح داده شود. 
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  بخش اول

  SQL Serverبرخی از دستورات مهم و کاربردي 

SQL توان با پایگاه داده یا بانک اطلاعاتی خود ارتباط یافته است که با آن میوجوي ساختبه معنی زبان پرس
ها را شود. جدول، دادهتشکیل می (table)از یک یا چند جدول  (database)برقرار کرد. یک پایگاه داده 

کند. ستون جدول، فیلد و هر سطر جدول یک در ساختاري شبیه به جداول معمولی (سطر و ستون) نگهداري می
  شود.رکورد گفته می

  ساختن دیتابیس:

 create database databasename; 

 ساختن جدول:

از نوع عددي  clscodeبه تعداد ده کاراکتر و  clsnameبا فیلدهایی به نام  clstableدر زیر جدولی به نام  
  در نظر گرفتیم: clscodeایجاد کردیم و کلید اصلی را فیلد 

Create table clstable 

( 

clsname char(10),  

clscode int, 

units int, 

clsun int 

primary key (clscode) 
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); 

  جدول مربوط به دانشجویان:

Create table stdenttable 

( 

stdname char(20),  

stdfam char(10), 

stdcode int, 

stdun char(20) 

primary key (stdcode) 

); 

 

 

 حذف جدول:

Drop table tablname; 

  از بانک. std مثال: حذف جدول 

Drop table std; 

 درج در جدول:

Insert into tablename(fieldname1,fieldname2) Values ('  ',  ); 

 

  قرار دادیم. 32مقدار نام را برابر احمد و کد را برابر   stdمثال: درج رکوردي در جدول 

INSERT INTO std  (stdname, stdcode) VALUES     (' ahmadi ', 32) 

 انتخاب و نمایش: 
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  : tablename از جدول fieldname2و  fieldname1استخراج اطلاعات 

select fieldname1,fieldname2 from tablename where   شرط ; 

 حذف رکورد یا رکوردهاي خاص از جدول:

delete from tablename  where   شرط ; 

  باشد:که نام آنها علی می stdمثال: حذف رکوردهایی از جدول 

delete from std  where   stdName='ali' 

  ویرایش فیلدهاي یک یا چند رکورد:

update tablename    set field1=value1 ,  . . .    where  شرط 

  هاي خاص بر اساس فیلد(هاي) یک یا چند جدول تعیین نمود.توان شرط یا شرطشرط: در قسمت شرط می

  شوند:هستند، انتخاب می 2و داراي مینترم  ahmadمثال: در شرط زیر کسانی که نام آنها 

Where name='ahmad' And minterm=2 

  در پایان دستور می توان نتایج را براساس فیلد (فیلدهایی) خاص مرتب کرد. 

Order by   نام فیلدخاص  

Group by نام فیلد خاص 

  اي:عملگرهاي مجموعه

 Union             اجتماع

تفاضل             Except 

اشتراك     Intersection 

  شود. اساس یکی از فیلدها استفاده میبراي حذف تکرارهاي خروجی بر distinct نکته: فیلتر
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Select sname, s#,score 

From stdtbl,clstbl 

Where ( شرط یا شرایط) 

SELECT    dbo.std.stdname, dbo.std.stdcode, dbo.clstable.clsname 

FROM    dbo.std CROSS JOIN    dbo.clstable 

WHERE     (std.stcode =1001) 

  الحاق دو جدول:

SELECT     dbo.std.stdname, dbo.std.stdcode, dbo.clstble.clstime 

FROM         dbo.std INNER JOIN 

      dbo.clstble ON dbo.std.clsid = dbo.clstble.clsi 

         که خروجی هاي استخراج شده از جداول به شرح زیر است.

eslami  mehdi 221 11         

Iman 222 11 

aahngar 223 11         

katanbaf 224 11         

Shirali 225 11         

Rakhasi 226 8          

Ahmad 232 8          

Navid 235 
8          
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algorithm  1 8          

software   2 11         

ood        3 14         

   

eslami  mehdi 221 NULL NULL NULL NULL 2 

Iman 222 NULL NULL NULL NULL 2 

aahngar 223 NULL NULL NULL NULL 2 

katanbaf 224 NULL NULL NULL NULL 2 

Shirali 225 NULL NULL NULL NULL 2 

Rakhasi 226 NULL NULL NULL NULL 1 

ahmad 232 NULL NULL NULL NULL 1 

navid 235 NULL NULL NULL NULL 1 
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  بخش دوم

  بانک اطلاعاتیایجاد 

  

  هاي زیر روي کامپیوتر شما نصب باشند: براي انجام این پروژه باید برنامه

• Microso  Visual Studio 2005 or later OR Microso  Visual C# Express Edi on 

• Microso  SQL server 2003 or later (Express Edi on) 
  

  کار مراحل زیر را دنبال کنید:رست کنیم. براي اینقبل از هر چیز باید بانک اطلاعاتی خود را د

 ).Windows Applicationي جدید ایجاد کنید (از نوع  پروژه .1

File > New > Project … > Visual C# > Windows 

 

 اکنون مسیر زیر را دنبال کنید: .2
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View > Solution Explorer  

  به پروژه اضافه کنیم.براي اینکار: ي ساخته شده است ولی باید بانک خود را تا اینجا پروژه

  روي نام پروژه خود کلیک راست نمایید و مسیر زیر را دنبال کنید: Solution Explorerدر پنجره  .3

Add > New Item … 

  مانند شکل زیر :   

 

  

  شود: اي مانند شکل زیر براي شما باز می .اکنون کادر محاوره4  
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اي نـام بانـک    را برگزینید.در پایین ایـن کـادر محـاوره   SQL Database ي  اي گزینه . در این کادر محاوره5

 را کلیک کنید.توجه شود که پسوند فایل بانک اطلاعاتی در اینجـا   addاطلاعاتی خود را وارد کنید و دکمه 

MDF ).است Microsoft-SQL Master Database File(  

امپیوتر شما نصب باشد بانک بدون هیچ مشـکلی  بر روي ک SQL server Express Edition. در اینجا اگر 6

شود.بلافاصله بعد از اینکـه بانـک    نمایش داده می Solution Explorerشود و آیکان آن در پنجره  ساخته می

شود، و از شـما   ظاهر می Data Source Configuration Wizardاي به نام  شما ساخته شد، کادر محاوره

خواهد که جداول و عناصر دیگر بانک اطلاعاتی خود را انتخاب کنید تا به دیتا سورس اضافه شـوند.چون   می

  کنیم. بانک ما فاقد هر گونه جدول است از این ویزارد صرف نظر می

را تعریـف   std. در این مرحله باید قبل از هرچیز جـداول برنامـه تعریـف شـوند.ما قصـد داریـم جـدول        7

  نماییم.بصورت زیر:

View > Server Explorer > DataBase1.Mdf > Tables (Right-Click) > Add New Table 
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  شود.که باید در آن نام فیلدهاي جدول خود را تعریف کنیم: . در این مرحله فرمی به صورت زیر باز می8

  

  در این فرم : 

  کند. ینام فیلد را تعیین م Column Nameستون 

  کند. نوع فیلد را تعیین می Data Typeستون 

  بپذیرد یا خیر. Nullتواند مقدار  کند که آیا فیلد تعریف شده می تعیین می Allow Nulls   ستون

گزینـه   Table Designerبراي تعیین فیلد کلید ، ابتدا فیلدي که قرار است کلید شود را انتخاب کنید سـپس از منـوي   
Set Primary Key  شود. کار یک آیکان کلید کوچک در کنار نام فیلد ظاهر میرا انتخاب نمایید.با انجام این  
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  : Query قیطر از جدول ساخت
  

کلیـک راسـت کـرده و گزینـه      Server Explorerاز پنجره  Database1.mdfبراي این کار روي 

New Query .را انتخاب می کنیم  
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  کنیم:زیر را وارد می SQLبندیم و در پنجره جدید دستور آن را میاگر پنجره انتخاب جداول باز شد 

CREATE TABLE  نام جدول ( 1نام فیلد 1نوع فلید  2نام فیلد ,   2نوع فیلد     ,  . . . ); 

  مثلا:

CREATE TABLE cls(name char(10), code int);  

  کنیم.را انتخاب می Execute SQLراست کلیک کرده و گزینه  Queryسپس روي پنجره ویرایشگر 
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ما اضـافه   Databaseشود و جدول جدید به نمایش داده می Queryآمیز ام اجراي موفقیتغسپس پی
  شود.می

  

  ایجاد ارتباط بین جداول:

  جداول

 stdtable(stdcode,stdname,stdfam,unname), 

clastable(clascode,clasname,units,unname) ,  

listtable(stdcode, clascode,scor1,scor2,scor3,scor4,final)  
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  را فرض کنید:

  کلید اصلی می باشد. clascodeو  stdcodeترکیب دو فیلد  listtableدر جدول 

یک کلید خارجی محسوب می شود زیرا در جدول  listtableدر جدول  stdcodeفیلد 

  دیگري کلید اصلی است.

خارجی محسـوب مـی شـود زیـرا در     یک کلید  listtableدر جدول  clascodeفیلد 

  جدول دیگري کلید اصلی است.

استفاده کند. براي این منظور  clastableو  stdtableهاي از داده listtableخواهیم می

  کنیم.استفاده می database diagramsاز 

RightClick ->Add New Diagram ->  رسم خط ارتباطی  <- انتخاب جداول مرتبط

 و تایید

  شود.دستور کلید خارجی براي جدول ترکیبی تعریف می با این

باشد مثلاً اگـر از رکوردهـایی در سـایر    کار با کلید خارجی مفید ولی بسیار حساس می

توان در جدول مبدا آن را حذف کرد براي انجام صـحیح  ها استفاده شده باشد نمیجدول

ف کـرد تـا خطـاي کلیـد     این کار باید ابتدا رکوردهاي مربوطه را در جدول مقصد حـذ 

  خارجی رخ ندهد.
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  بخش سوم

  هاي استفاده شده در پروژهآشنایی مفهومی با کلاس

هاي مورد اسـتفاده شـده، روش تعریـف    لازم به ذکر است که در این بخش فقط کلیات مفهومی کلاس
ها ذکر گردیده است ي آن کلاسهاي استفاده شدهها، کاربرد متدها و خاصیتشیءاي از نوع آن کلاس

  شد. خواهدانجام  بعدسازي آنها به طور دقیق در بخش توضیحات تکمیلی و پیادهولی 

-و متـدهاي مهـم آن   هـا هاي استفاده شده و خاصیتهدف از این بخش تنها آشنایی مقدماتی با کلاس

  هاست.

  شوند:مهمترین اشیاء به دو دسته تقسیم می  ADO.NETدر تکنولوژي 

  datatableو   datasetهاي ها:  مانند کلاسبراي نگهداري و مدیریت دادهاشیایی  -1
 commandsو   connectionsهاي : مانند کلاس(datasource)براي ارتباط با منبع داده اشیایی  -2

 توان به دو نوع تقسیم کرد:را میاشیا ته ساین د

-استفاده مـی  Oracleو   Accessمانند  SQLهاي غیر که بیشتر براي بانک OlbDBاشیاء  -1

 شود.

ي داراي سـرعت بـالاتر   ،شونداستفاده می MS SQL Serverبراي که وقتی   SQLاشیاء -2
  .هستند

  : System.Dataفضاي نام 
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قرار دارد. این فضاي نام خـود نیـز شـامل     System.Dataدر فضاي نام  ADO.netکلاسهاي اصلی 
  چند فضاي نام دیگر است که مهمترین آنها عبارتند از:

-   System.Data.SqlClient  System.Data.OleDb  
System.Data.Odbc - System.Data.OracleClient  

هـاي  هایی اسـت کـه بـراي دسترسـی بـه بانـک      شامل کلاس System.Data.SqlClientفضاي نام 
  رود.  به کار می SQL  Serverي لاعاتی ایجاد شده به وسیلهاط

  کرد. ضمیمهآنرا به برنامه  usingبراي استفاده از این کلاس باید با استفاده از 

using System.Data.SqlClient;  

بایـد فضـاي نـام     DataTable و DataSet ماننـد  ADO.NETهـاي پایـه   براي اسـتفاده از کـلاس  
System.Data .را نیز به برنامه اضافه کنیم  

using System.Data; 

DataTable چیست؟  

) RAMهاي موجود در جدولی از بانک خـود را بـه حافظـه (    توانیم با استفاده از این کلاس داده ما می
ها در قالب سطر و ستون نگهـداري  در این کلاس داده هاي آن کار کنیم. منتقل کنیم تا بتوانیم روي داده

  شوند.می

  از نوع این کلاس: dtنحوه تعریف شیءاي به نام 

DataTable dt = new DataTable(); 

DataSet چیست؟ 

قرار دارند. در واقع یک دیتاست شامل یک یا چنـد  اي از جداول است، که در حافظه  وعهدیتاست مجم
DataTable     جـدول کنـد و اطلاعـات   است. یک دیتاست همانند یک مخـزن در حافظـه عمـل مـی 

  دارد.  ها) را در خود نگه می(جدول
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  از نوع این کلاس: dsنحوه تعریف شیءاي به نام 

DataSet  ds = new DataSet ();  

  :SqlConnectionکلاس 

قرار دارد و براي ایجـاد ارتبـاط بـین برنامـه و      System.Data.SqlClientاین کلاس در فضاي نام 
تـوانیم بـا اسـتفاده از    اي از ایـن کـلاس مـی   گیرد. پس از ایجاد شیپایگاه داده مورد استفاده قرار می

بانـک  و مهمتـرین ویژگیهـاي   یر اي اسـت، مس ـ که یک خاصیت رشته ConnectionStringخاصیت 
  نظر را به آن اختصاص دهیم.اطلاعاتی مورد

-استفاده مـی دي مشابه قطعه کد زیر براي ایجاد شیءاي از این کلاس و اختصاص مسیر موردنظر از ک

  هاي مختلقی براي این کار وجود دارد.)(البته روش کنیم.

SqlConnection  con; 

con = new SqlConnection(); 

s = @"Data Source=(local)\SQLEXPRESS;AttachDbFilename ="; 

s+= @"مسیربانک اطلاعاتی\(theDBName).mdf;"; 

s += ";Integrated Security=True;Connect Timeout=30;User Instance=True"; 

con.ConnectionString=s; 

 

  باید نام بانک بانک اطاعاتی خود را وارد کنیم..(theDBName) بدیهی است که بجاي 

  نک اطلاعاتی دارد.بادو متد براي شروع و اتمام ارتباط برنامه با  SqlConnectionکلاس 

 ;()con.Open     براي باز کردن ارتباط

 ;()con.Close        براي بستن ارتباط 
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  SqlCommandکلاس 

این کـلاس حـاوي یـک دسـتور      قرار دارد. System.Data.SqlClientاین کلاس نیز در فضاي نام 
SQL توانـد یـک دسـتور   هاي بانک اطلاعاتی است. این دستور میبراي اجرا روي دادهSELECT  یـک،
یک پروسیجر ذخیره شـده در بانـک    تواند نام یمباشد. حتی  SQLو یا دیگر دستورات  INSERTدستور

  اطلاعاتی باشد.

  :کنیمزیر استفاده می اتبراي ایجاد شیءاي از نوع این کلاس از دستور

SqlCommand com;  
com = new SqlCommand();  

    Connection خاصیت 

آن را تنظـیم کنـیم.    Connectionبایـد خاصـیت    SqlCommandبراي استفاده از شیء اي از نوع 
براي ارتبـاط بـا بانـک     SqlConnection مقدار این خاصیت را برابر مقدار شیءاي که از نوع کلاس

  دهیم.مورد نظر ایجاد کردیم قرار می

com.Connection=con;  

  CommandTextخاصیت 

ذخیـره   جریک پروسی نامیا ( SQLتواند حاوي یک دستور این خاصیت متنی را دریافت می کند که می
کـه در   SQLباشد که باید روي داده اجرا شود. به عنوان مثال قطعه کد زیر یک نمونه از دسـتور   شده)

این خاصیت قرارداده شده است را نمایش می دهد. این قطعه کد براي درج یک رکورد با مقادیر مورد 
  نظر مورد استفاده قرار می گیرد.

Com.CommandText= "insert into std(stdcode,stdname) values(123,'ALi')"  

  

  :( )ExecuteNonQueryمتد 
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  ()ExecuteNonQuery دستور با اسـتفاده از فراخـوانی متـد    يام مراحل فوق براي اجراجاز ان بعد
را اجرا کنید. همانطور که از نام این متد مشخص است زمانی  SqlCommandدستور موجود در شی 

ر ا  ايدادههـیچ   insertدارد که بخواهیم دستوري را روي بانک اجـرا کـرده و ماننـد دسـتور     کاربرد 
هایی) را از بانک برگردانیم هماننـد زمـان اسـتفاده از    (داده برنگرداند. ولی در صورتی که بخواهیم داده

  توانیم براي اجراي آن از این متد استفاده کنیم.نمی SELECTدستور 

 دهـیم. هایی را که در بالا ذکر شد، انجام مـی ارتباط و انجام عملیات به وسیله کلاسحال روش ایجاد 

متـدهاي   خاصیت و و هااي از ایجاد ارتباط و درج رکورد قید شده است. تمام کلاسدر زیر مثال ساده
  استفاده شده مربوط به آنها در صفحات قبلی ذکر گردیده است.

using System; 

using System.Collections.Generic; 

using System.Text;  
using System.Data.SqlClient; 

using System.Data; 
namespace WindowsApplica on1 

{ 

    class mydataaccesslayer 

    { 

private SqlConnection con; 

private SqlCommand com; 

con = new SqlConnection(); 

com = new SqlCommand(); 

strDirectory =  "پوشه ي حاوي فایل بانک" ; 

con.ConnectionString= 
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@"DataSource=.\SQLEXPRESS;AttachDbFilename="+strDirectory+@\DBName.m
df;Integrated Security=True;User Instance=True"; 

com.Connection = con; 

         com.CommandText="insert into std(stdcode,stdname) values(123,'ALi')
 ; 
         con.Open();     

com.ExecuteNonQuery();    
        con.Close();      

     } 

} 

  SqlDataAdapterکلاس 

این کلاس همانند پلی بین جداول بانک اطلاعاتی قرار دارد.  System.Dataاین کلاس در فضاي نام 
نگهداري میشوند، عمل  DataTableو یا  DataSetو نیز داده هاي موجود در حافظه که به وسیله ي 

 و   SqlConnectionمــی کننــد. ایــن کــلاس بــراي دسترســی بــه بانــک اطلاعــاتی از کــلاس  

SqlCommand .استفاده می کند   

  این کلاس از دستور زیر استفاده می کنیم: براي ایجاد شیء اي از نوع

SqlDataAdapter da; 
da = new SqlDataAdapter();  

  SelectCommandخاصیت 

براي دریافت داده هاي مورد نیاز در برنامه از بانک اطلاعاتی  DataAdapter این خاصیت در کلاس
  به کار می رود. DataTableو یا  DataSetو نیز قرار دادن آنها در 

اطلاعـات را از بانـک بگیریـد بایـد خاصـیت       DataAdapterقبل از ااینکه بخواهید به وسـیله ي  

SelectCommand   را تنظیم کنید. این خاصیت شیءاي از نوعSqlCommand    دریافت کرده کـه
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این شیء مشخص می کند داده ها چگونه باید از بانک اطلاعاتی انتخاب شده و نیز چه داده هایی بایـد  
  خاب شوند.انت

ایجـاد مـی شـوند      SqlCommandهمانطور که در بخش قبل نیز گفته شده بود اشیایی که از کلاس 
هـاي  خود نیز خاصیت هایی دارنـد کـه قبـل از اسـتفاده بایـد مقـدار دهـی شـوند یعنـی خاصـیت          

Connection  و CommandText  .  

  

  ( )Fillمتد 

موجـود در خاصـیت    SQLتوانیـد دسـتور   مـی  DataAdapterبا اسـتفاده ا ز ایـن متـد در کـلاس    
SelectCommand هاي برگشتی از اجراي این دسـتور از  را در بانک اطلاعاتی اجرا کرده، سپس داده

-فیلـدها را نیـز بازیـابی مـی     formatو  typeایـن متـد    در حافظه قرار دهید. DataSetدرون یک 

  ایجاد کنید. DataTable و یا  DataSetنوع  البته قبل از استفاده از این متد، باید شیءاي ازکند.

DataTable dt = new DataTable(); 
da.Fill(dt);  

  

کنـیم.  بیان مـی stdtable يرا در پروژه DataTableحال با مثالی دلیل استفاده از این کلاس و کلاس
مـا بخـواهیم    توانستیم عملیاتی را در بانک خود اعمال کنیم حال ممکـن اسـت  در مثال قبل، ما تنها می

تـوانیم از متـد   داده (داده هایی) را به عنوان پاسخ از بانک خود دریافت کنـیم در ایـن صـورت نمـی    
ExecuteNonQuery  مربوط به کلاسSqlCommand .استفاده کنیم  

کنـیم و در  هاي جدولمان را انتخاب می، داده SQLمربوط به  SELECTدر مثال زیر با استفاده از دستور 
  دهیم.  قرار می DataTableیک 

using System; 
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using System.Collections.Generic; 

using System.Text;  
using System.Data.SqlClient; 

using System.Data; 
namespace WindowsApplica on1 

{ 

    class mydataaccesslayer 

    { 

private SqlConnection con; 

private SqlCommand com; 

SqlDataAdapter da;         

con = new SqlConnection(); 

com = new SqlCommand(); 

strDirectory =  "پوشه ي حاوي فایل بانک" ; 

con.ConnectionString= 

@"DataSource=.\SQLEXPRESS;AttachDbFilename="+strDirectory+@\Database
.mdf;Integrated Security=True;User Instance=True"; 

con.Open();            

         com.Connection = con; 

         com.CommandText= "select * from std ";  

     da = new SqlDataAdapter(); 

        da.SelectCommand = com; 

        DataTable dt = new DataTable(); 

        da.Fill(dt);           
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        con.Close();      

     } 

} 

 

  DataGridViewکنترل 

رود. این کنترل خاصیتی کار میه هاي موجود در پایگاه داده باین کنترل براي نمایش داده
 DataTableو یـا یـک    DataSetتوانـد بـا یـک    دارد کـه مـی   DataSourceبه نام 

  مقداردهی گردد.

  مقدار دهی گردد تنها کد زیر کافی است. DataTableدر صورتی که با یک 

dataGridView1.DataSource = dt;  
که منبع  DataSourceمتصل گردد باید علاوه بر  DataSetاما در صورتی که به یک 

دیتاگرید خود را مقداردهی  DataMemberخاصیت  ،کندمی صداده هاي ما را مشخ
تعیین شود و ما باید با می اي از جداول را شاملکنیم. زیرا دیتاست مجموعه

DataMember  ول اجد ی ازارتباط دیتاگرید خود را با یکبا نام جدول موردنظر
  مشخص نماییم.

dataGridView1.DataSource = ds; 

dataGridView1.DataMember = " std";  

DataBindings  

  خود متصل کرد. tableرا به رکورد جاري  TextBoxتوان کنترل با استفاده از این خاصیت می

textBox1.DataBindings.Add("text", dt, "stdCode"); 

textBox2.DataBindings.Add("text", dt, "stdName"); 
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  DataTableتوانستیم این کنتـرل را بـه    DataBindingsدر خاصیت  Addبا استفاده از رویداد که 
 پارامتر است. 3داراي کنید این متد  طور که ملاحضه میهمان متصل کنیم.

  خواهیم مقادیر فیلدها به آن نسبت داده شود. کند که می پارامتر اول خاصیتی را مشخص می

  خواهیم اطلاعات را از آن بخوانیم. کند که می ي را مشخص می DataTableپارامتر دوم 

 ش داده شوند.نمای TextBoxخواهیم مقادیر آن در  کند که می پارامتر سوم نام فیلدي را مشخص می

 

  : ComboBoxاتصال کنترل 

اي تنظیم شود که هر کدام از عناصر لیستش شامل مقـدار فیلـدي   تواند به گونه می comboBoxکنترل 
  :خود نیز می توان به شیوه ي زیر عمل کرد comboBoxاز رکوردهاي بانک باشد.براي اتصال کنترل 

           comboBox1.DisplayMember = "stdname"; 

           comboBox1.ValueMember = "stdcode"; 

            comboBox1.DataSource = dt;  

  ایم.را مقداردهی کرده comboBoxکنید در اینجا سه خاصیت طور که مشاهده میهمان

DisplayMemberخواهیم مقدار کنیم که می: فیلدي را تعیین میcomboBox .بر اساس آن باشد  

ValueMemberمان را باید مشخص کنیم.: فیلد کلید جدول  

DataSourceخواهیم از آن اطلاعات را بخوانیم.: باید جدولی را مشخص کنیم که می  
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  بخش چهارم

  StdTable يپروژه یعمل يساز ادهیپ

معنـی  ایـن بـدین    یک زبان کاملاً شیء گراسـت.  #Cطور که دانشجویان عزیز اطلاع دارند، زبان همان

شـوند نیـز    هایی که به این زبان نوشته مـی  ها سروکار دارد و برنامهاست که این زبان با اشیاء و کلاس

باید از این قاعده تبعیت کنند و بر مبناي شـیءگرایی نوشـته شـوند. مـا نیـز در ایـن پـروژه از روش        

  کنیم. شیءگرا براي نوشتن پروژه خود استفاده می

  

وسیله آن دکمـه کـاربر   ه درون آن فرم تعدادي دکمه وجود دارند که ب است. ي ما داراي یک فرم پروژه

همچنین کاربر با کلیک  هاي بانک اطلاعاتی را دستکاري (درج، حذف، اصلاح و ...) کند. تواند داده می

  تواند اطلاعات دستکاري شده بانک را مشاهده کند. می "نمایش"بر روي دکمه 
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اند و باید کد نویسی را براي دسـتکاري جـداول شـروع     نیاز ما تعریف شدهتا این مرحله جداول مورد 

 نـام  قبل از هر چیز باید کلاسی ایجاد کنیم که ارتباط ما با جدول فیزیکی بانک را برقـرار سـازد.   کنیم.

  گذاریم. می MyDataAccessLayerاین کلاس را  دلخواه

  باشد. این کلاس داراي چهار خاصیت و چهار متد می

  ها : صیتخا

public string database = "database1.mdf";         

private SqlConnection con; 

private SqlCommand com; 

private SqlDataAdapter da; 

  کند. خاصیت اول نام بانک اطلاعاتی ما را مشخص می  

آنها پیشتر ارائـه  شوند که توضیحات  هاي بعدي براي کار با بانک اطلاعاتی استفاده میخاصیت

  گردید.

  و همچنین متدها:

public void connect()  

{ 

     string cs = @"Data Source=.\SQLEXPRESS;AttachDbFilename=D:\New folder 

(2)\test\test\WindowsApplica on1\Database1.mdf;Integrated Security=True;User 

Instance=True"; 
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      cs = string.Format(cs, this.database); 

      con.ConnectionString = cs; 

      con.Open(); 

} 

public void disconnect()  

{ 

con.Close(); 

} 

public DataTable select(string s)  

{ 

     com.CommandText = s; 

      DataTable dt = new DataTable(); 

      da.Fill(dt); 

      return dt; 

} 

public void docommand(string s)  

{ 

     com.CommandText = s; 

      com.ExecuteNonQuery(); 

} 
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  شود. متد اولی براي اتصال به بانک استفاده می

  شود. متد دومی براي قطع اتصال از بانک استفاده می

  شود. ها از جداول بانک استفاده می متد سوم براي انتخاب داده

  شود. غیر دستور انتخاب استفاده می SQLمتد سومی براي اجراي یک دستور 
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ــده اســـــــت:  ــر آورده شـــــ ــن کـــــــلاس در زیـــــ ــل ایـــــ   کـــــــد کامـــــ

 

  

using System; 

using System.Collections.Generic; 

using System.Text; 

using System.Data.SqlClient; 

using System.Data; 

 

namespace WindowsApplication1 

{ 

    class mydataaccesslayer 

    { 

        public string database = "database1.mdf"; 

         

        private SqlConnection con; 

        private SqlCommand com; 

        private SqlDataAdapter da; 

        public mydataaccesslayer()  

        { 

            con = new SqlConnection(); 

            da = new SqlDataAdapter(); 

            com = new SqlCommand(); 

            com.Connection = con; 

            da.SelectCommand = com; 

        } 

        public void connect()  

        { 
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متـد، متـد سـازنده کـلاس      بـه ایـن   دقت شود که این کلاس داراي متدي همنام بـا خـودش اسـت.   

 هاي کلاس است. گوییم.کار این متد مقداردهی اولیه خاصیت می

  ف این کلاس در پروژه مسیر زیر را دنبال کنید:یبراي تعر

Solution Explorer > (right click on project name) > Add >  Class… 

 

 

  ذارید.بگ MyDataAccessLayerدر کادر محاوره ظاهر شده نام کلاس را 

هـا و   توانیـد خاصـیت   اکنـون مـی   با این کار شما یک فایل کلاس خالی به پروژه خود اضافه کردیـد. 

توانید خاصیت ها و متدهایی که در بـالا لیسـت    براي راحتی کار می هاي خود را به آن اضافه کنید. متد

  اند را به فایل کلاس خود اضافه کنید. شده
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هـاي   تا این کـلاس فقـط روي داده   جدول،کلاس متناظر آن را ایجاد کنیم.ر این مرحله باید براي هر د

  کنیم که داراي خاصـیت  را تعریف می STDClassکلاس  STDمثلا براي جدول  همان جدول کار کند.

  باشد: و متدهایی به شکل زیر می

  

  ها : خاصیت

public string stdname; 

public  int stdcode; 

public  int midterm; 

public int final; 
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 متدها

 Stdها دقیقا متنـاظر بـا فیلـدهاي جـدول      شوند که خاصیت اگر دانشجویان عزیز دقت کنند متوجه می

تعریف شوند تا بتوان در کلاسـهاي دیگـر از    Publicها حتما باید به صورت  البته این خاصیت هستند.

ــیت  ــن خاص ــرد.  ای ــتفاده ک ــا اس ــیت  ه ــی از خاص ــلاس     یک ــیئی از ک ــده، ش ــف ش ــاي تعری ه

MyDataAccessLayer .هـا و   ما با استفاده از این کلاس به دادهي همانطور که گفته شد پروژه است

  کند. جداول بانک اطلاعاتی خود دسترسی پیدا می

  

public DataTable selectall() 

        { 

            string sql = "select * from std "; 

            _mydal.connect(); 

            DataTable dt = _mydal.select(sql); 

            _mydal.disconnect(); 

            return dt; 

        } 

        public void upd()  

        { 

            string sql = "update std set stdName='{0}' WHERE stdCode = {1}"; 

            sql = string.Format(sql, this.stdname, this.stdcode); 

            _mydal.connect(); 

            _mydal.docommand(sql); 

            _mydal.disconnect(); 

         

        } 
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  : ()Formatتابع 

 شـود.  بندي آنها اسـتفاده مـی  ها و قالب است براي دستکاري رشته stringاین تابع که متدي از کلاس 

  بسیاري دارد. ها کاربرد این تابع در برنامه

string sql="insert into std(stdcode,stdname) values({0},'{1}')"; 

sql = string.Format(sql, this.stdcode, this.stdname); 

 

ایـن   formatسپس با استفاده از تابع  اي قرار داده شد. رشته sqlي  در دو دستور بالا ابتدا درون رشته

   رشته دستکاري گردیده است.

  اي است که قرار است دستکاري گردد. پارامتر اول رشته

کنند که قرار است درون رشته به جـاي پارامترهـا جـایگزین     پارامترهاي بعدي مقادیري را مشخص می

  شوند.

  شوند. مشخص می {}پارامترها با 

    .شود } جایگزین می1و همینطور پارامتر سوم به جاي { {0}بدیهی است که پارامتر دوم به جاي 

 که درون آن قرار دارد، رشته بودن آن را مشخص می کند. }1{ کوتیشن که نماد،  '{1}'در 

  نمایش دهیم. DataGridViewهاي جدول را بخوانیم و در یک  خواهیم ابتدا داده اکنون می
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سپس در رویداد کلیک دکمه نمـایش   را به فرم اضافه کنید. DataGridViewکار یک کنترل براي این

  زیر را وارد نمایید: کدهاي

private void bu on1_Click(object sender, EventArgs e) 

{ 

            stdClass _s10 = new stdClass(); 

            dt = _s10.selectall(); 

            dataGridView1.DataSource = dt; 

} 

 

  سازد. می STDخط اول شیئی از کلاس متناظر با جدول 

قـرار   dtکنـد و درون   را با استفاده از کلاس متناظر انتخـاب مـی   STDهاي جدول  خط دوم تمام داده

  است. DataTableدر اینجا یک  dt دهد. می

  دهد. نسبت می DataGridView1را به  dtخط سوم 

از  استفاده شده است.این کلاس ابتدا با اسـتفاده  StdClassکلاس  SelectAllدر این قطعه کد از متد 

هـاي انتخـاب شـده را بـه      کند سپس داده را اجرا می selectدستور  MyDataAccessLayerکلاس 

  گرداند. برمی DataTableصورت یک 

ي خـود اضـافه کـردیم. رکـوردي را بـه       که به پروژه "اضافه"خواهیم با کلیک روي دکمه  اکنون می

  کدهاي زیر را وارد کنید: ،کار در رویداد کلیک دکمهبراي این اضافه کنیم. STDجدول 
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private void bu on3_Click(object sender, EventArgs e) 

        { 

            stdClass _std = new stdClass(); 

            _std.stdcode = Convert.ToInt32(textBox2.Text); 

            _std.stdname = textBox1.Text; 

            _std.addfromform(); 

        } 

  این کد و سایر کدهاي دیگر بسیار ساده بوده و نیازي به توضیح ندارند.
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  بخش پنجم

  ایجاد فایل اجرایی از پروژه 

براي ایجاد فایل اجرایی از پروژه ي خود ابتدا باید مسیر زیر را رفته که یـک پـروژه ي جدیـد ایجـاد     

  نمایید.

File > New > Project … 
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  کنیم.ایجاد می Setup Projectاي از نوع طور که مشاهده می کنید پروژهسپس همان

Other Project Types > Setup and Deployment > Setup Project 

  کنیم.سپس مسیر و نامی را که براي ذخیره شدن فایل اجرایی مد نظر داریم را وارد می
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 Apllication Folderبـر روي   File System(setup)پس از اینکه این پروژه ایجاد شد در قسمت 
  کنیم.را انتخاب می ...Fileو درنهایت  Addي کلیک راست نمود پس از آن گزینه

در کادري که ظاهر میگردد به سراغ مسیر پروژه ي برنامه اي که می خواهیم ازآن فایل اجراي درسـت  
  پروژه رفته و فایل هاي موجود در آن را انتخاب میکنیم. bin>debug ، به قسمت کنیم رفته 

و همچنین فایل بانک اطلاعاتی مورد استفاده شده، تصاویر و یا دیگر فایلهاي پروژه ي مورد  exeفایل 
  اضافه گردد Project Setupاستفاده در پروژه ي اصلی خود را انتخاب تا به 

را بزنید)  تا فایـل   F6را انتخاب کرده (یا تنها  Build Soulationگزینه ي  Buildدر نهایت از منوي 
  اجرایی ساخته شود.

   

  

  

  

که در اول همین بخش  Setupمربوط به مسیر پروژه ي  Debugفایل اجرایی ایجاد شده در پوشه ي  
  ایجاد کردیم ساخته می شود.  
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  بخش ششم    

  

  در برنامه XMLاستفاده از 

  

Xml  هـا بتواننـد بـا یکـدیگر      هاي تجاري براي اینکه برنامـه  یک زبان انتقال اطلاعات است. در محیط

افزارهـاي   هـاي تجـاري نـرم    ارتباط برقرار کنند باید از یک زبان انتقال استفاده کنند. منظـور از برنامـه  

  یا حسابداري و... است.افزار انبارداري  افزارهایی مانند نرم معمولی مانند آفیس و ... نیست. بلکه نرم

  استفاده کرد. xmlممکن است فکر کنید که براي انتقال اطلاعات چرا باید از 

  * چرا از بانک اطلاعاتی استفاده نکنیم؟  

شـباهت   Xml فرمت استانداردي است و توسط همه شناخته شده اسـت.  xmlدر جواب باید گفت که 

  شود. ت از تگ استفاده میدارد. یعنی براي انتقال اطلاعا htmlبسیاري به 

  در چیست ؟   htmlو  xmlتفاوت    

 html دهد در حالی که ها را نمایش میدادهXML   دهد.  ها را ارائه میداده  

  است : xmlاي از چند عنصر  مثلا کد زیر نمونه
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<Book> 

<Title>Learning Visual C# 2005</Title> 

<ISBN>XXXX-XX-XXX</ISBN> 

<Subject>Programming</Subject> 

</Book> 

  

  

  : XMLذخیره رکوردهاي یک جدول در یک فایل 

  کپی کنید: MyDataAccessLayerبراي اینکار متد زیر را در فایل 

  

public DataSet select2DS(string s, string sTableName) 

        { 

            da = new SqlDataAdapter(com); 

            DataSet ds = new DataSet(); 

            da.SelectCommand = new SqlCommand(s); 

            da.SelectCommand.Connection = con; 

            da.Fill(ds, sTableName); 

            return ds; 

        } 
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کنیم.سـپس   ذخیـره مـی   Datasetگیریم و در یـک   با استفاده از این متد ما اطلاعات را از بانک می

باید متدهاي زیـر   STDي  باید متدهاي زیر را در کلاس متناظر با جدول خود اضافه کنید.مثلا در پروژه

  را اضافه کرد:

public void writeAllToXML(string sFileName) 

        { 

            string sql = "select * from std "; 

            _mydal.connect(); 

            DataSet ds= _mydal.select2DS(sql, "std"); 

            ds.WriteXml(sFileName); 

            _mydal.disconnect(); 

        } 

 

public DataTable readAllFromXML(string sFileName) 

        {             

            _mydal.connect(); 

            DataSet ds = new DataSet(); 

            ds.ReadXml(sFileName); 

            _mydal.disconnect(); 

 

            return ds.Tables[0]; 

        } 

را در یک  STDرا گرفته سپس رکوردهاي جدول  XMLي متد اول این است که مسیر یک فایل  وظیفه

ي  کنـد. وظیفـه   ذخیره مـی  xmlي اطلاعات را آن فایل  همه ر آخرکند. د ذخیره می dsدیتاست به نام 

خوانـده  و در   xmlرا گرفته سپس رکوردها را از آن فایل   xmlمتد دوم این است که مسیر یک فایل 
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کند .در آخر تنها جدول موجود در آن دیتاست کمکی را به عنـوان   ) ذخیره میdsیک دیتاست کمکی (

را بـراي   STDاي اضافه کنیم که دکوردهاي جـدول   گردان. سپس در فرم خود باید دکمه خروجی برمی

  کنیم: کند.کدهاي زیر را در رویداد کلیک دکمه اضافه می ذخیره می xmlما در یک فایل 

stdClass _s10 = new stdClass(); 

_s10.writeAllToXML("c:\\stdTable.XML"); 

  کند. ذخیره می stdTable.xmlرا در فایل  STDکدهاي بالا رکوردهاي جدول 

کنیم سپس کدهاي زیـر را   اي را به فرم اضافه می براي خواندن اطلاعات ذخیره شده در فایل فوق دکمه

  کنیم: به رویداد کلیک آن دکمه اضافه می

  

stdClass _s10 = new stdClass(); 

DataTable dt = _s10.readAllFromXML("c:\\stdTable.XML"); 

dataGridView1.DataSource = dt; 

  

  

بــا آرزوي توفیــق و ســربلندي، خواهشــمند اســت هــر نــوع نظــر و پیشــنهادي داریــد، بــه ایمیــل  

r.k.shahvandi@gmail.com  .ارسال فرمایید  
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